4. cviceni: Zakladni kroky v programu ArcGIS GIS1 - tvorba map

Layout — zavérecné upravy mapy

Layout, nebo-li vykres, pfedstavuje prostredi pro kone¢nou Upravu mapy. Pravé v prostiedi layoutu
se z dosavadnich dat stane mapa. Zde do mapy pfidavame legendu, ndzev, méritko a predevsim
usporadavame jednotlivé prvky mapy do vysledné podoby.

Pro pfepnuti z prostoru View (to je prostor, ve kterém jsme dosud pracovali) do prostoru Layout
slouzi tlacitka, umisténd v levém dolnim rohu mapového pole:
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Pro préci v layoutu se aktivuji také nové nastroje pro praci s vykresem:
: : —m— : .
[& [& [ Ed 5| [ W ¥ 5

Vykres se nezobrazuje ve skutecné velikosti. Okynko s procenty uddva, jaké je zobrazeni vykresu.
Abychom spravné vidéli mapu a usporadani jednotlivych prvkd v ni, je nutné obcas prepnout na 100
% zobrazeni.

Pro praci s mapou pouzivame stejné ndstroje, jako jsme pouzivali doposud.

Prvnim krokem je nastaveni velikosti vykresu. Od toho se odviji dalsi prace. Kliknéte kdekoli
v prostoru vykresu mimo oblast mapy. Zvolte moznost Page and Print Setup:

Printer Setup

Name: (BT E SN ~| Properties. | | |V tomto dialogovém okné
Status: Ready volime velikost a orientaci
Type: NRG 1205/1208/1202 PCL & vykresu a mapy. Jestlize
Where:  147.251.182.251 chceme mit vyslednou mapu
Comments sy . .
paper na vysku, musime nastavit
Size: A4 (210 x 297 mm) =] [ | Printer Paper Portrait, pokud ji chceme na
cource [Rto Tray seiet E Printer Margins Sitku, zvolime mozZnost
Landcape.
Orientatior * Portrait " Landscape |:| Map Page [Page Layout) P

Sample Map Elements

Map Page Size

™ Use Printer Paper Setting:
Page
Standard |Custom ﬂ
Width |20,99?4 |Centimeters ﬂ
Height [ 29,6960 |centimeters |
Orientatior * Portrait " Landscape
u ™ scale Map Elements propartionally to changes in Page Siz

QK | Cancel

U Nastavte si vas vykres — A4, Portrait.

& Upravte mapu tak, aby vhodné vyplfiovala vykres. Nastavte okraje na 2 cm — vyuZijte k tomu
méritkové listy v horni a levé &asti layoutu.

L Dejte si 100 % nahled vykresu a zkontrolujte umisténi popisek. Pokud nékteré popisky nevyhovuiji
(jsou daleko od bodu, prekryvaji se apod) prekliknéte se do View, do prostoru, kde se vdm zobrazi
geograficka data, popisky prevedte na anotace. Upravte popisky a predevsim je pfepiste na Ceské
nazvy pro staty i mésta. Reky mizete ponechat.
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Zakladni kompozicni prvky mapy
Co patii mezi zakladni kompoziéni prvky? Nazev, legenda, méritko, tirdz, mapové pole.

Zakladni kompozi¢ni prvky pfiddme pomoci zadlozky Insert:

i |Insert Selection Tools Windom

[ & Data Frame 1:35 5&t
o T Pro pfidani nazvu mapy vyuZijeme Title. V horni ¢asti mapy se

ma LIt . , , oy , - .
 Emd ZEE objevi textové pole, do kterého napiSeme ndzev. Chceme-li jakkoli
A Tedt B nazev mapy upravit, klikneme 2x levym tlacitkem a v novém
" g MNeatline... dialogovém oknu miiZeme nazev prepsat, nebo pomoci Change

+ Legend Properties zménit typ pisma, velikost, styl.

] Morth Arrow... % Pridejte do mapy nazev mapy.

== 5cale Bar... s

Em Scale Text...

[Z] Picture... K

Object...
=

Dalsim krokem je pfidani Legendy. Klikneme na volbu Legend... Legenda se vytvari v nékolika krocich:

e wert ==

— Choose which layers you want to include in your legend

Map Layers: Legend Items
- obratniky obratniky
I8 | re W_-JAM

re k].r_; i Rovnik
- Rovnik ca_podobrys
- 54 _podobrys S5A_POLIT

- CAmerica_Union

7|
e d
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[ [

Set the number of columns in your |1 _I?
Preview |

< Ipét I Dalii = I Storno |

V Legend Wizard zvolime, které vrstvy se maji zobrazit v legendé (Legend Items) (pozn. v pfipadé
politické mapy se vrstvy, ktera vykresluje jednotlivé stity, vynechava). Pomoci Sipek uprostied do legendy
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pridame, nebo naopak odebereme vrstvy. Pomoci Sipek vpravo usporadame jednotlivé polozky

legendy. Set the number of columns in your umoznuje nastavit pocet sloupcl v legendé.

V dalim kroku uréujeme nazev legendy. Ceska kartografie striktné zakazuje pouzivat nazev legenda,
proto jej vidy vymazeme! V nékterych pripadech sem mlzeme doplnit nazev legendy, pokud ho

potiebujeme uvést.

i

—

—Legend Title

Legend

—Legend Title font properties

Size: 14 -

Font: I@ Segoe Ul

[ | x|

— Title Justification

You can use this to
control the
justification of the
title with the rest of
the legend.

e

Preview |

< Zpét I Dalii = I

Storno

V dal$im kroku nastavujeme ordmovani a podbarveni legendy:

Border
.
z
Background
.
z
Drop Shadow
.
z
Gap Rounding
Ilﬂ,00_|: I 0 _I; %

Preview |

e S =
— Legend Frame

< Zpét I Dalii = I Starnao

Border — zde nastavujeme
oramovani legendy

Background — podklad
(podbarveni legendy)

Drop Shadow — stinovani
legendy.

Gap urcuje mezeru mezi
oramovanim, podkladem a
textem legendy.
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Dalsi dva kroky doporucujeme projit a ponechat bez povsimnuti. K dplnému dotvoreni legendy byva
nejvhodnéjsi jeji ,,rozbiti“ a upraveni presné na miru. Klikneme Dokoncit a legenda se zobrazi
vV mapé.

L Viozte k mapé legendu. Legenda bude obsahovat pouze tyto poloZky: Hlavni mésta, jezera, feky.

Dale do mapy pfidame méritko. MéFitko mizZeme pridat bud grafické nebo Ciselné. Nejvhodnéjsi je
méritko grafické (Insert -> Scale bar). Nevyhodou grafického méritka v prostfedi ArcGlIS je jeho
prednastaveni pro anglosaskou kartografii. Proto budeme vzdy nuceni upravit méritko tak, aby
vyhovovalo ceské kartografii.

0 500 1000 1500 2000km

& PFidejte do mapy toto méfitko: lmm—I\ ' ' |

Nejprve vybereme z nabidky Scale Bar vhodné méritko, které umistnime do prostoru mapy, klikneme
na néj pravym a zvolime Properties. V Properties méfitko upravime tak, aby odpovidalo ¢eskym
kartografickym pravidlim:

Stiidavé grafické méfitko —I_JroEerties L |E WS Prynim krokem je, Ze zvolime

jednotky méftitka (Division

Format ] Frame ] Size and Position ]

_ Units) a klikneme pouZit.
Scale and Units l Mumbers and Marks ]

e Teprve poté nastavujeme
cdle
ostatni parametry, jako

Division value: umistnéni popisku (Label

Mumber of division Position), popisku (Label),

nakonec navolime parametry
Number of subdivisiQ vy, . e .
meéritka: Division value,

[~ Show one division before zera Number of divisions a

iZing... Number of subdivision. Pro
Adjust width nastaveni hodnoty pro

, Division value musime
Units

.

nejprve v poli When resizing
Division Units:

zvolit Adjust with/Adjust
Kilometers ..
@ number of division.

Label Pasition:

Klikneme pouzit a pfepneme
se do zalozky Numbers and

=
=
| Marks.

| OK | Storno
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Stfidavé grafické méfitka - PmErﬁes; |

Format I Frame | Size and Position | | Vtéto zdloZce nastavujeme, které
Scale and Units Mumbers and Marks Cisla se na méritku maji zobrazit
~Mumbers (Frequency), a ktera rozdéleni

Fre (Marks) maji byt vykreslena.

Position:

| sbove bar A7 mame jednotlivé parametry

Gap:l 25 '_I? Mumber Format.. méfitka vykresleny, klineme
nejprve Pouzit, poté OK.

I
Sy'mhcul...l
— Marks
Frequency:
Idivisinns LI
Position:
IAbnve bar LI

Division Height: IS_SBE_I? Symb::ul...l
Subdivision Heigh1|4,16!_l? Sy'mhnl...l

QK I Storno PouZit

Dalsim krokem je pfiddani tirdZe. Tirdz by méla obsahovat jméno autora a pfipadné dalsi informace,
které chce autor do mapy pfidat (datum, zdroj dat apod.)

e Qe

Text | Size and Position |

Text: Tiraz priddme pomoci Insert -> Text. Nevyhodou
ext:
Katefina Mrézkova - je, Ze se tiraz umistni automaticky doprostred
Brno, 2010

mapy. Je mozné do ni hned psat. Dalsi Upravy jsou
mozné po dvojitém kliknuti do prostoru tiraze.
Pomoci Change Symbol Ize tirdZz upravovat. Tirdz
vétSinou umistnime do pravého dolniho rohu.

Font: |5egoeu11u,nn ==l ==

Pfidejte do mapy tiraz.
Angle: I 0,00 _I;‘ Character 0,00 _:I % J py
Leading: 0,00 _:I
About Formatting Text | Change Symbaol... |
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Do Layoutu je moZné vloZit celé textové pole, obrdzek (Insert -> Picture) a dalsi prvky.
Upozornéni!

Vidy, kdyZz chceme zménit néjaky prvek, je nutné ho nejprve aktivovat. To provedeme tak, Ze
klikneme levym tlacitkem kdekoli mimo vykres a poté klikneme na dany prvek (legendu, méfitko,
text). Okolo aktivovaného prvku se objevi modry ramecek:

o . Sy "l"""k'.F

e

D’T‘_ﬁ:i'j o

Manualni tprava legendy

Kdyz uz mdme mapu témér hotovou, provedeme posledni Upravu legendy — pfevedeme legendu na
grafiku.

Vytvorené zakladni kompozi¢ni prvky, popsané v predchozi podkapitole, nevyhovuji vidy predstavam
tvlrce mapy. Napriklad legenda malou ¢asti zasahuje do mapového pole a posunem neni mozné se
tomuto konfliktu vyhnout. Proto existuje tzv. ,rozbijeni”, které ma za nasledek oddéleni napf.
jednotlivych polozek legendy. S legendou pak nepracujeme jako s celkem, ale ménime naprosto
libovolné jakoukoli jeji ¢ast.

Rozbiti legendy se provadi tak, ze klikneme na legendu pravym tlacitkem mysi a zvolime: Convert to
Graphics.

[ Zoom Whole Page

= Loom to Selected Elements

X Cut Ctrl+ X
: Copy Ctrl+C
> Delete Delete

N Conyert To Graphics

Graphic Operations 3
Order »
Mudge p
Align 4
Distribute »
Botate or Flip 4

Properties...
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Timto krokem jsme legendu prevedli na grafiku. Déle je nutné oddélit od sebe jednotlivé polozky
legendy. Znovu klikneme na legendu pravym tlacitkem a zvolime Ungroup:

[ Zoom Whole Page
< Zoom to Selected Elements

& Cut Ctrl+X
Copy Ctrl+C
> Delete Delete

e Ungowp |

Graphic Operations 2
Qrder 3
Mudge 2
Align b
Distribute 3
Rotate or Flip »

Properties...

i B gy
;‘":"j o _— > g:l_i:i'h

Stejnym postupem od sebe Ize oddélit i jednotlivé polozky legendy (symbol a text) a upravit je:

]
.

g qf— I%-I'""

AZ bude legenda upraven3, je potieba ji celou oznacit, kliknout na ni pravym tlacitkem a zvolit Group.
Poté musime nastavit v Properties ordmovani a pfipadné podbarveni legendy.

Upozornéni!

Prevedeni na grafiku (Convert To Graphics) je nevratnou funkci. Po jejim spusténi neni napft.

v vz,

méfitko propojeno s pivodnimi daty — pfi zméné méritka se méritko v layoutu nezméni!
& Upravte legendu pievedenim legendy na grafiku — pokud potfebujete.

& Aktivujte si mapové pole a kliknéte pravym tlaéitkem. Zvolte moZnost Properties a v Properties
vyberte zalozku Frame. Zvolte svétle modrou barvu pro podklad mapy.
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Geograficka sit

Pro dokonceni mapy je jesté zapotrebi pridat geografickou sit. Klikneme pravym tla¢itkem do
prostoru mapy a zvolime Properties. Ze zaloZek vybereme Grids — New Grid. Pro pfidani geografické
sité je nutné projit nékolika kroky a nakonec upravit néktera prednastaveni.

& Viozte do mapy geografickou sit.

Grids and Graticules Wizard lgﬂ_g

—Which do you want to create?

& Graticule: divides map by meridians and parallels

" Measured Grid: divides map into a grid of map ur

™ Reference Grid: divides map into a grid for indeaxi

Grid name: | Graticule

< Fpet I Dalsi = I Starno

Ponechdme tak, jak je nastaveno a klikneme dalsi:
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-Create a graticule

—Appearance

BPI0TW SIPI0W A0

" Labels only Style:

™ Tick marks and labels —l

¥ Graticule and labels

—Intervals
Deg Mir Sec
Place parallels every Il':I I 0 I 0 Jatitude
Place meridians v:.*1.rv:3r].r|:|-'5I I 0 I 0 Jongitude

< Zpét I Dalii = I storno

Ponechdme tak, jak je nastaveno a klikneme dalsi:

Axes and labels

SPOW - Axes

Line style:
[T Major division ticks

Line style:
[T Minor division ticks

Mumber of ticks per majar

—Labeling

Text style: LTI |

< Zpét I Dalii = I Storno

Zde odklikneme obé zatrzitka v poli Axes. Zvolime Dalsi.
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Crea_

B0HN0TW
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Wrats
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SAL_X

— Graticule Border

¥ Place a simple border at edge of graticule

" Place a calibrated border at edge of graticule

Properties... |

— Meatline

[” Place a border outside the grid —l

— Graticule Properties

™ Store as a static graphic that can be edited

e Store as a fixed grid that updates with changes
to the data frame

< Ipét I Finish I

Storno

V poli Graticule Border ponechame pfednastavené, ale zménime barvu linie, na tmavé modrou.

Zvolime Finish.

Drive nez dame OK, zvolime Properties a upravujeme vlastnosti geografické sité.

V zéloZce Labels upravime vlastnosti (velikost pisma, barvu a font) popisku:

Reference System Properties hﬂgl
Axes | Interior Labels Labels |Lines | Hatching | intervais |
| Label Axes
V¥ Top [V Left ¥ Bottom W Right
— Label Style
FormatIDegrees Minutes Seconds ;I
Font: I@ 5egoe UL LI
Size: Iﬁ 'l Bl fl Hl

Caolar:

| additional Properties... |

—Label Orientation
Vertical
[~ Top [~ Left [~ Bottom [ Right

oK storno FouZit

V poli Label doporucujeme zvolit 3 — toto
pole urcuje vzdalenost mezi popiskou a
osou.
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Klikneme na Additional Properties..., kde nastavime dal$i podminky, podle niZze uvedeného vzoru:

Grid Label Properties

DMS Label |

Label type: IStandard LI

— Direction Indication
[~ Show coordinate direction labels

[~ Show minus sign for negative valu

— Fractional Values

[ Abbreviate labels with fractional values
show I 0 j decimal

— Minutes

[” Show zero minutes

Font: ICI Segoe Ul LI ililgl
Size: |3 vl Colon -l"l

— Seconds

[~ Show zero seconds

Font: |a Segoe UL ;I il ilgl
Size: |3 vl Color: -l"

oK I storno | PouZit |

V zéloZce Lines zménime barvu linii, nejvhodnéjsi je svétle modra. Klikneme pouzit a OK.

Axes I Interior Labelsl Labels Lines |Hatching I Inter\ralsl

— Display Properties

* Show as a grid of lines

" Show as a grid of ticks r.lm
" Do not show lines or ticks _.m

Symbol:

oK I storno PouZit
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Export mapy

Poslednim krokem export mapy do podoby obrazku. Export se provadi pres File -> Export Map.
Nejvhodnéjsim formatem pro uloZeni mapy je GIFF, TIFF, BMP nebo PDF. Vyvarujte se formatu JPG,
ktery nedodrzuje barevnost.

Pfed uloZenim doporucujeme rozkliknout Options a nastavit Resolution 200 dpi.

% Vyexportujte mapu jako obrazek a uloZzte ji do vasi slozky. Mapu (obrazek) vlozte do Odevzdavéany
k predmétu GIS1 — Tvorba map.



